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World Radiocommunication Seminar 2016(WRS-16)
HFBC Exercises

Exercise 1 — g@] HFBC REQ 1.4 - Data Capture

Purpose and objectives:

A simple requirement file for notification to the ITU has to be created and saved using the Data Capture
software HFBC REQ 1.4.

Input data:
e Requirement file should cover the season B16 (October 2016 — March 2017)
e Administration: Malaysia (MLA)
e First requirement to be included in the notification file:

Frequency: 6050 [MHz]

Transmission time slot: 00:00-16:00 [UTC]

Coverage aria: Malaysia, 54 [CIRAF zone]

Transmitter site location: Kajang, code: KAJ

Transmitting power: 50 [kW]

Azimuth of the maximum radiation: 0 [Degrees]

Antenna slew angle: 0 [Degrees]

Antenna type: Quadrant antenna HQ1/0.5, antenna code: 926
Days of operation: From Monday to Sunday, code: 1234567
Start Date: 30/10/2016

Stop date: 26/03/2017

Modulation: Double-side, code: D

Language used for the transmission: Malay, language code: Mly
Broadcaster: Radio Television Malaysia, code: RTM

Frequency manager organization: Radio Television Malaysia, code: RTM
Alternative frequency: None

Data type: new requirement, code N

O 0O OO O0OO0OO0OO0OO0OO0OO0OO0OO0OO0OO0OO0o0OO0o

e Second requirement to be included:

Frequency: 6080 [MHz]

Transmission time slot: 04:00-07:00 [UTC]

Coverage aria: Malaysia, 54 [CIRAF zone]

Transmitter site location: Kajang, code: KAJ

Transmitting power: 100 [kW]

Azimuth of the maximum radiation: 0 [Degrees]

Antenna slew angle: 0 [Degrees]

Antenna type: Quadrant antenna HQ1/0.5, antenna code: 926
Days of operation: From Monday to Sunday, code: 1234567
Start Date: 30/10/2016

Stop date: 26/03/2017

Modulation: Double-side, code: D

Language used for the transmission: Malay, language code: Mly
Broadcaster: Radio Television Malaysia, code: RTM
Frequency manager organization: Radio Television Malaysia, code: RTM
Alternative frequency: None

Data type: new requirement, code N

O 0O 0O 0O O0OO0OO0OO0OO0OO0OO0OO0oOO0OOoOO0oOOoOOo

o
1. Capture the first requirement:
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2. Add the first requirement as a new requirement:

@ ITU RR12 submi
File

Display Tools Preferences

Season

Source

No of requirements:

All requirements

Click below o select requirement

Help Frangais Espafiol

B16

3. Modify the first requirement to capture the second one:

Enter/Change data as required.

Freq/Band Start time Stop time StatDate Stop Date Days Dperation AltFreg 1
6050 0 [ 00 6 | 00 30/10/2016 26/03/2017 1234567

Site Site name Target Citafs AltFieq 2

‘ KAJ Kaiang ‘smw ‘

At Code Antenna designation P kK Slew Max szm Mod Design Freq AltFieq 3
926 F1 705 50 ‘ 0 0 D ‘

Adn Mt Bic EMO Lanquage FRemarks Datatype
MLA ‘ MLA ‘ RTH RTH ’Wﬂ N

Save changes I #dd as aNEW requirement I Delete requremert: Clear alfiskds
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e D Tools Preferences Help Frang ol

Season Enter/Change data as required.

No of recuirements

B16
Source
Freg/Band Start time Stop time Start Date Stop Date Days Dperation AltFreg 1
1 6080 ‘ 04 ‘ [ ‘ 07 ‘ 00 | 30/10/2016 2640372017 1234567

All requirements Sie Sitz name Taige Cirefs AltFiea2
Click below o select requirement ‘ KaJ [Kajang. MLA ‘SANW ‘
I 6050 0000-1600 KA (1) I Ant Code Antenna designation Por ki Sler Masden Mod Design Fieg AltFiead
926 ’ﬁn 05 100 ‘ 0 ‘ 0 D ‘ ‘
Adm it Bre EMO. Lanquace Remarks Data ype
MLA MLA RTHM RTH |M Iy ‘ ‘ N
Save changss Acld a5 a NEW recuirement D et recirement Clear al fskds

Lza_\k»

4. Save the notification file.
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Exercise 2 — 5 HFBC VAL 2.0 - Data validation

Purpose and objectives:

Open an existing requirement file correct and validate it for season B16 using the Data Validation software
HFBC VAL 2.0.

Input data:

e Existing requirement file: BI6GMLA _errors.txt

File Edit Validaste Tools Help Frangais Espafiol

6 error(s): Total number of requirements = 12

B16 MLA 20-JUN-2016

; ITU HFBC Validation v 1.0
; generated from previous submitted requirement file B15T1-018836-MLA.txt

; for ITU NOTIFICATION
; Total number of requirement: 12

: With the exception of the first line (containing season, notifying org., date)
; Lines starcing with ; (semicolon) are ignored by the software.

; created by HFBCREQ 1.4 on 27/7/2015 10:35:29 AM

:FREQ STRT STCP CIRAF ZONES LOC POWR AZIMUTH SLW ANT DAYS FDATE TDATE MOD AFRQ LANGUAGE  ADM BRC ORG REQ# OLD ALT1 ALT2 ALT3 NOTES

5264 0000 2400 S4NW KAJ 100 0 O 926 1234567 301016 260317 D 5965 Mly MLA RTM RIM 1 ¥
6050 0000 1600 54NW KAJ 50 360 0 926 1234567 301016 260317 D 6050 Mly MLA RTM RTM 2 ¥
€080 0400 0700 54NW K&J 100 0 0 926 1234567 301016 260317 D 6080 Mly MLA RTM RIM 3 ¥
6100 0000 1600 54NW KAJ 100 0 0 926 1234567 291016 260317 D 6100 Mul MLA RTM RTM 4 ¥
6175 1000 1600 S54MW KLJ 100 0 0 801 1234567 301016 260317 D 6175 5 ¥

5TA 100 45 0 141 1234567 301016 260317 D 7270 4 ¥
7295 0000 2400 S4NW KAJ 100 0 O 926 1234567 301016 260317 D 7285 7 ¥
9750 1000 1600 545 KAJ 100 150 0 145 1234567 301016 260317 D 9750 8 ¥
9835 0000 2400 S4NE HA&J 100 93 0 148 1234567 301016 260317 G 9835 ] ¥

11665 0100 1600 S4NE K&J 100 93 0 001 1234567 301016 260317 D 7255 10 ¥

11885 1000 1200 44N, 458W KLJ 100 25 0 218 1234567 301016 260317 D 11885 1 ¥

15295 0400 1000 55,58-60 KALJ 250 133 0 218 1234567 301016 260317 D 15295 Mly, ENG MLA RTM RIM 12 ¥

Change the start / stop date of the season - Correct and validate the file: AI6MLA old

B HFBC deta validation
File Edit Validate Help Francais Espafiol

Search »
13 error(s); T Sort s

Change Season Start/Stop Date to... » A16: 27/03/2016-30/10/2016

Change frequency ranges
ALT: 26/03/2017-20/10/2017

B17: 29/10/2017-25/03/2018

¢ for ITU NOT| Remove requirements NOT in 512 bands
: Total numbs g

; With the exception of the first line (containing season, notifying org., date)
; Lines starting with ; (semicolon) are ignored by the software.

created by HFBCREQ 1.4 on 27/7/2015 10:35:29 AM

REQ STRT STOP CIRAF ZONES LOC POWR AZIMUTH SLW ANT DAYS FDATE TDATE MOD AFRQ LANGUAGE ADM BRC ORG REQ# OLD ALT1 ALT2 ALT3 NOTES

5965 0000 2400 54NW

0 926 1234567 27 301016 D 5965 Mly MLA RTM RTM 1
€050 0000 1600 54NW 0 926 1234567 27 301016 D €050 Mly MLA RIM RTM 2
6030 0400 0700 54NW 0 926 1234567 27 301016 D 6080 Mly MLE RTM RTM 3
6100 0000 1600 54NW 0 926 1234567 27 301016 D 6100 Mul MLA RTM RTM 4
6175 1000 1600 54NW 0 801 1234567 27 301016 D 6175 Mul,Mly MLE RTM RTM 5
7270 2200 1630 S4NE 0 141 1234567 27 301016 D 7270 Mly MLA RTM RTM &
7295 0000 2400 54NW 0 926 1234567 27 301016 D 7295 Eng MLL RTM RTM 7
9750 1000 1600 545 0 145 1234567 27 301016 D 9750 Mul MLA RTM RTM &
9835 0000 2400 S4NE 0 148 1234567 27 301016 D 9835 Mly MLE RIM RIM 9
11665 0100 1600 54NE 0 148 1234567 27 301016 D 7255 Iba MLE RTM RTM 10
11885 1000 1200 44N, 45NW 0 218 1234567 27 301016 D 11885 Chi MLA RTM RTM 11
15295 0400 1000 55,58-60 0 218 1234567 27 301016 D 15295 Mly, ENG MLA RTM RIM 12
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Exercise 3 — g ITU HFBC 5.3 — Propagation and compatibility
analysis

Purpose and objectives:

Analyze the Basic Service Reliability (BSR) and Time Service Circuit (TSC) for specific group of
requirements published in ITU HFBC schedule (in the list view mode).

Input date:

e (CD-ROM) HFBC Schedule B16T2.

Solution - Steps to be followed:
1. Execute ITUHFBC 5.3 software.
2. Open schedule: B16T2

3. Select “List view”

B 60 TO COMPATIEILITY ANALYSTS MODE - B16T2 0n
Schedule Preferences Help Francais Espaiiol

Display requirements from 3 . . o
Move ¢ play requirements. Right-Click with cursor elsewhere to show Menu
»

| BT | B16T2 (2095 requirements)
75
S
18 19 .’_ﬂz@ 22 55 o | 25 | 2f
N o |
P \,{" SFf 34 ( é i
Sk O = s
B | R L
z
#
_L_ a0 N .t:ta w \ B2
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4. The list view is displayed:
Click on item to display detailed information. Click +/- to expand/contract n

B16T2 (2895 requirements)

Administration
o AFG (30}

- ALB{41)

o ALG{17)

- AOT(27)

- BLR {5 )

- BOT (37

- BOL{50)

- CHH (860 )

CSTWS T

5. Display requirements from an administration:
From “View” menu, select “Display Requirements from”, then select “Administration: MLA (Malaysia)”.

6. Click on the MLA (12) to expand the requirements from Malaysia.



B16T2 adm="MLA’ (12 requirements)

Administration
- HLA{12)
(REF) FEEQ M STET-STOP ADM FHMO CIRAF ZONE SIT PUR AZM ANTENHA
934y 5965 D 0000-2400 MLA RTH S4HW Kal 100 0 HQl-0.5
--------- (935) &050 D 0000-1600 MLA RTH S4HW Kal 50 0 HOl-0.5
--------- (936) 6030 D 0400-0700 MLA RTH S4HW Kal 100 0 HOl-0.5
(937) 6100 D 0000-1600 MLA RTH G4KHW EAT 100 0 HOl-0.5
(938) 6175 D 1000-1600 MLA RTHM S4HW KA 1000 LPH19-C-45.-45-1-20-300
939y 7270 D 2200-1630 MLA RTH S4NHE ST& 100 45 AHR(S)2-1-0.5
--------- (940 7295 D 0000-2400 MLA RTH S4HW Kal 100 0 HOl-0.5
--------- (941) 9750 D 1000-1600 MLA RTH 545 EAT 100 150 AHR(S)2-2-0.3
(942) 9835 D 0000-2400 MLA RTH GS4HE EAT 100 93 AHR(E»2-2-1.0
--------- (942) 11665 D 0100-1600 MLA RTHM S4HE EAT 100 93 AHR(E»2-2-1.0
--------- (9443 11885 D 1000-1200 MLA RTH 44N, 45HW KaAJ 100 25 AHR(S)4-4-1.0
--------- (945 15295 D 0400-1000 MLA RTH 55.58-c60 KAJ 250 133 AHR(S5)4-4-1.0
7. Note the some requirements are displayed in red and some in blue.
8. Note the status bar at the bottom:
Requirements in RED have BSR or TSC less than 50% RR12 ref tables ¥=2017 Mon=1 SEN=27 S/N=34dB SA=17dB FR=SkHz

Requirements in RED color have BSR or TSC less than 50%.
Requirements in BLUE color have BSR or TCS more than 50%.

9. Analyze data for the requirements:

BSR and TSC values are presented as numbers from 0 to 9 (from 0% to 90%) for each transmitting hour and
for each seasonal period:

November —beginning of the season;
January —middle of the season;
March —end of the season.

10. Click on a requirement (935) and (936) to display detailed results:

B16T2 adm="MLA’ (12 requirements)

Administration
=--HLA{12)
(REF) FREQ M STRT-STOF ADM FMO CIRAF ZOHE SIT PWR AZM ANTENHA
+ (934) E965 D 0000-2400 MLA RTHM G4HW KaT 100 0 HO1-0.5
B (935) 6050 D 0000-1600 MLA RTH S4HW K&l 50 0 HO1-0.5
- BSR HO0010203040506070809101112131415

How & 8766555677888 88
Jan 87 765556778888 8%8
----- Har 8776545567 88882388

& TSC HO0010203040506070809101112131415 Interfered Cirafs (VantedsUnwanted FS) (REF) FREQ M STRT-STOP ADM FMO SIT CIRAF ZOHES
How 9999999993397 230%86
——————————————————— X — S4NW(39-61-58-54dBu) (11253 6055 D 1400-1500 CHN RTC HNN 49SE
————————————————— EE - — S4HVW{37-41-58-46dBu) (8203 G045 D 1200-1400 THA IBE UDD 43, 44
THEXYXEZEZXXEXZEZYE XXX G4NU(38-34-50-33dBu) (4673 G055 D 0000-2400 J FHE HAG 45
Jan 9999999999 762204
——————————————————— X — 54NW(36-60-57-55d4Bu) (1125) 6055 D 1400-1500 CHN RTC HHN 495E
————————————————— E X - — 54NV{36-41-58-47dBu) (8203 6045 D 1200-1400 THAZ IBE UDO 43, 44
I---=-=-=-=-=-=-=-=----- S4NW({27.-31-27-31dBu) (578) €050 D 0020-0100 EQ& HCJ QUI 11.12
----- Har 9999993999386 330%6
——————————————————— ¥ — S4FW{39-60-58-54dBu) (11253 6055 D 1400-1500 CHM RTC HHN 49SE
777777777777 E X - — S4NV{40-43-59-46dBu) (8203 6045 D 1200-1400 THA IBE UDO 43, 44
TEHEZXYXEXEZXXEXEIYE XXX G4NU(39-35-35-19dBu} (467) €0D5L D 0000-2400 J FHEK HAG 4%
= (936) 6080 D 0400-0700 MLA RTH S4HW Kal 100 0 HQ1-0.5
- BSR HO40506
How 768
----- Jan 666
----- Har 666
= TSC HO40506
How 999
----- Jan 799
----- Mar 999
(937) €100 D 0000-1800 MLA RTH G4HW KaT 100 0 HQ1-0.5
(938) €175 D 1000-1600 MLA ETH L4HW KaT 100 0 LPH19-5-45-45-1-20-300
(939) 7270 D 2200-1630 MLA RETH S4HE ST 100 45 AHR(S)2-1-0.5
(9403 7295 D 0000-2400 MLA RTM G4HW KaT 100 0 HO1-0.5
(941) 9750 D 1000-1e00 MLA RTH 545 K&J 100 150 AHR(S)2-2-0.3
(942) 9835 D 0000-2400 MLA RETH S4HE KaJ 100 93 AHR(S)2-2-1.0
(943) 11665 D 0100-1600 MLA RTH G4HE KAT 100 93 AHR(S)2-2-1.0
(9443 11885 D 1000-1200 MLA RTH 44H, 4SHT KaJ 100 25 AHR(S)4-4-1.0
(945) 15295 D 0400-1000 MLA RTH 55.58-60 KaJ 250 133 AHR(S)4-4-1.0




11. Determine the potential interference received from other requirements:
Interfered CIRAF zones, Wanted /unwanted FS, requirements causing interference.

12. From “View” menu, select “Go to Map view”,

oo "MODE - | ROM -
Schedule Preferences Help Frangais Espaiiol
Display requirements from v
Click o1 . Click +/- to expand/contract n
Grouped by v
ED 4 B16T2 adm=LA’ (12 requirements)
Gaan  Beendallnodes
.1 Prntlist
P ADH FHO CIRAF ZOKE SIT PUR AZM ANTENNA
Show sclected requirement 0 MLA RTH 54T KA 100 0 HO1/0.5
I Go to Map view I 0 MLA RTH 54T KAJ 50 0 HQLAD.S
HLA RTH S4NU KAI 100 0 HQL/D.S
B £937) 6100 D 0000-1600 MLA RTH G4NU KiJ 100 0 HOL/D.S
B (938) 6175 D 1000-1600 MLA RTH G4NU KAl 100 0 LPH19-5.45/45/1,20-300
B (939) 30 MIA RTH G4HE STa 100 45 AHR(S)2-1/0.5
B 0 0 HIA ETH G4NU 100 0 5
HOO0102030405060708051011121314151617181920212223
5988877888688 8806887432113
FEBTFTTIAE8988806873110001
898877788898 880088665200¢2
HOOD102030405060708091011121314151617191920212223 Inteviered Cirafs (Wanted/Unvanted FS) (REF) FREQ M STRT-STOP ADM FMO SIT CIRAF ZONES
789999999992211221160000
I X X G4NU(6/49-53/45dBu) (13033 7290 D 2025-2400 CHN RTC EEI 43SE, 4450
I - GANU{3,47-34/31dBu) (2871) 7300 D 2200-2300 OMA BAE SLA 497
S4NT{2045-60-45dBu) (1301) 7290 D 1100-1605 CHN RTC BEI 43SE, 4450
an
S4NU{5-45-25-26dBu) (1303) 7290 D 2025-2400 CHN RTC EEI 43SE, 4450
SANT(10-45-60-45dBu) (1301) 7290 D 1100-1605 CHN RTC BEI 43SE, 4450
AN 9-44-21-31dBu) (2871) 7300 D 2200-2300 OMA BAE SLA 497
ar
S4NT(6.749-58-50dBu) {1303) 7290 D 2025-2400 CHN RTC BEI 43SE. 4450
S4NT(747-29,31dBu) (2871) 7300 D 2200-2300 OMA BAE SLA 497
SN (22-36-49-37dBu) {1309) 7295 D 2000-2100 CHN RTC URU 37—40_ 47E. 4BNU

13. Display requirements from a specific administration: MLA (Malaysia)
Note that the location of the transmitter sites is shown on the map. You may use “zoom”: click in the specific
region, inside Asia.

14. Right click the transmitter site KAJ to display all requirements from that site:

82
41 - Click below to select/unselect requirement
[N (934) 5965 D 0000-2400 MLA RTIM KAJ 54NW ) -

(935) 6050 D 0000-1600 MLA RT KAJ 54NW \v B
(936) 6080 D 0400-0700 MLA RTM KAJ 54NW 4] 'ia T -~
(937) 6100 D 0000-1600 MLA RTM KAJ 54NW - \B\
(938) 6175 D 1000-1600 MLA RTM KAJ S4NW 51 -
(940) 7295 D 0000-2400 MLA RTIM KAJ 54NW e

(941) 9750 D 1000-1600 MLA RTM KAJ 545 |

(942) 9835 D 0000-2400 MLA RTM KAJ 54NE r = I
(943) 11665 D 0100-1600 MLA RTM KAJ SANE
(944) 11885 D 1000-1200 MLA RTM KAJ 44N 45NW
(945) 15295 D 0400-1000 MLA RTM KAJ 55,58-60

and select the requirement REF. (936) from the list of the MLA requirements.



OTO COMPATIB

Schedule Tools Preferences Help Frangais  Espariol

Move cursor on Tx site and Right-Click to display requirements. Right-Click with cursor elsewhere to show Menu

Wanted : (936) 6080 D 0400-0700 MLA RTM KAJ 54NW and potential interferers (4)
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The antenna pattern of the selected requirement (936) is displayed on the map in blue. The requirement
appears in the list as Wanted. Other “Unwanted” requirements are indicated as potential interferes. Potential
interfering requirements on the same channel are displayed in red, those on the adjusting channels +/- 5 kHz

in yellow, and those in on +/- 10 kHz channels in green.
15. From “Tools” menu, select “Calculate”, then “Run compatibility analysis”.
The software calculates...

16. A chart of the median Overall Circuit Reliability (OCR) in % for each hour of operation is displayed:

Modian Overall circuit reliability {OCR) in % for each Hour of Oparation




No interference is expected....

17. Display the compatibility analysis on the map:
From “Tools”, select “Show Map”.

B GO TO COMPATIBILITY ANALYSIS MODE - B16T2 on ITU HFBC CD-ROM - [TU HFBC 5. =E

Schedule Tools Preferences Help Francais Espariol

Move cursor on test points and Left Click to display results. Right Click with cursor elsewhere to show Menu

Overall circuit reliability (OCR) in % for Hour 04

75
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74

[Warted {936) 6080 D 0400-0700 MLA RTM KAJ S4NW
Unwarted: (1143) 6080 D 21500530 CHN RTC HLR 335
Unwanted: (1344) 6075 D 2200-0600CUB  HAB 7.10.11
Unwanted: (2155) 6080 D 0400-0500 STP IBB SAO 475,52,535 57
Unwanted: ~ (2156) 6080 D D500-0700 STP BB SAO 46.47

18. Detailed results:

- Left-click on a Test Point: detailed results for that point:
l/ a2 ! 44 r_,{:_,.) @_f&

/ 45

5%@ 64

41 b OCR %=70, F5 at test point 749 in Ciraf 54NW
46,6 (W) (936) 6080 D 0400-0700 MLA RTM KAJ 54NW

- Display the other parameters: Field Strength, Power received, Basic circuit reliability, Signal to
Interference, Overall circuit reliability.
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From “Tools”, select “Select Values”, then:
- “FS” — Field Strength

- “PWR” — Power received

- “BCR” — Basic circuit reliability

- “Stol” — Signal to Interference

- “OCR” — Opverall circuit reliability

GO TO COMPATIE] = =

Schedule Preferences Help Frangais  Espafiol

Select Hour 3 . .
Move ¢ ght-Click with cursor elsewhere to show Menu
Select Values 3 FS
Select Value Types 3 PWR
BCR Overall circuit relia
Show Chart
stol T
Change target cirafs v | OCR _,_—-’__"ﬁ
Save results _@;/_ -ﬁ!—-_q
{ Print interference report <] 22l 2z
"] Show selected requirement E-

Wf_h I M

- Switch between the different types values: Minimum, Median, and Maximum of the currently
displayed parameter.

From “Tools” menu, select “Select Values Types”, then “Minimum”/’Median”/”Maximum”.

19. Save results and print report:

. GOTO COMPATIBILITY ANALYSIS = ROM - TTU
Schedule | Tools | Preferences Help  Frangais  Espafiol
Select Hour 3 L ) i )
Move c isplay results. Right-Click with
Select Values 3
Select Value Types 4
Overall
Show Chart
e am—
Change target cirafs _____,_.——h.—-—r-ﬂ’_--ﬁ
Save results _gf =
‘{ Print interference report =1 27 2
"1 Show selected requirement S-

WA‘é)/_—\_.d i __/—-—u_ff\z_{
T = |
N

20. Examine another requirement Ref. (945)
- From “Tools” — Show selected requirement.
- From “Tools” — Show all requirements
- Repeat steps from 14 to 18.
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[ GO TO COMPATIBILITY ANALVSIS MODE - B1672 on CD-ROM - ITU HFBC 5. S=AToR]
Schedule Teols Preferences Help Frangais Espariol

Move cursor on test points and Left-Click to display results. Right-Click with cursor elsewhere to show Menu

Overall circuit reliability (OCR) in % for Hour 04

OcR

Eour 04
] >4
03]
\ r 83
. (e
’_ 1E085]
] 150353
I 03]
u 1033 a3
ml | 23]
] ] [io43] - -
u w0 72 73 67 WW 71
| s 70 ?
[ wumea okEz

74

[iarted: 1{945) 15295 D 0400-1000 MLA RTM KAJ 55.58-60
Unwanted: (2350) 15290 D 0800-1000 F NHKSS 46.47

- “Skip” zones.....
- Change colors:
- Spectrum occupancy mode:
Shows requirements targeting specific CIRAF zones in specific bands for specific hours
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Exercise 4 — HFBC ANT 1.0 — HF transmitting antennas

Purpose and objectives:
Display horizontal and vertical patterns of an antenna.
Input data:

e Curtain antenna, half-wave dipole array, dual band, centre-fed, no reflector. Antenna type:
CH1/1/0.3, antenna code: 700

This software is often used to determine the code, the description, and the parameters of the commonly used
HF transmission antennas.

Solution - Steps to be followed:
1. Execute the HFBC ANT 1.0 software.
2. Select the type of the antenna:

From the left menu “Antenna type”, select “CH (700-750)”, then from the list select “700 CH1/1/0.3”.

' HFBC Antennas

Antenna Code rmo Antenna Type Curtain antenna, half-wave dipole array, dual band, centre-fed, no
reflector

Antenna designation CHI/A0.3
Ground dielectr

Ground can

Operating fr

Mumber

Antenna Type

The selected antenna and its characteristics are displayed.

3. Select an antenna by specifying its code:
Type the code in the “Antenna code box”:
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- \HFBC Antennas

Antenna Code 701| Antenna Type Curtain antenna, half-wave dipole array, dual band, centre-fed, no

reflector
Antenna designation CHLA1/0.5

4. Print the antenna parameters:
From the left menu, click on “Print”.

5. Mouse-over the diagrams, display the attenuations.



